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About This Guide

This guide describes how to use Fabric Manager to manage your SAN Integrated Switch.

This section covers information about:

■ Naming Conventions, page ix

■ Related Documents, page x

■ Text Conventions, page x 

■ Symbols in Text, page xi

■ Getting Help, page xi

Naming Conventions
Throughout this document, references to the StorageWorksTM Fibre Channel SAN Switch 
Integrated/32 and Integrated/64 by Compaq, will be designated as follows:

■ The term “SAN Integrated Switch” is a generic reference to both or either model.

■ The terms “IS/32” or “IS/64” are specific references to either model.

Each of the six individual switches comprising the SAN Integrated Switch will be referred 
to as either: 

■ A switch element

■ The Fibre Channel SAN Switch 16-EL

The term “switch” refers to any combination of StorageWorks Fibre Channel SAN 
switches, SAN Integrated Switches and switch elements.



x  Fabric Manager for the Fibre Channel SAN Switch Integrated/32 and Integrated/64, Version 1.0

Related Documents
Related product information can be found in the following Compaq publications:

Text Conventions
This document uses the following conventions to distinguish elements of text:

 Related Documents
Document Title Part Number

Fibre Channel SAN Switch 16-EL Installation and Hardware Guide AA-RNAPC-TE

Fibre Channel SAN Switch Integrated/32 and Integrated/64
Installation and Hardware Guide

AA-RPDFC-TE

Command Console for Hubs, Switches, and Tape Controllers Getting Started Guide AA-RHDAD-TE

Fibre Channel SAN Switch Management Guide AA-RMMJB-TE

Keys Keys appear in boldface. A plus sign (+) between two keys 
indicates that they should be pressed simultaneously.

USER INPUT User input appears in a different typeface and in uppercase.

FILENAMES File names appear in italic, initial capital letters, except 
when case-sensitive.

Menu Options, 
Command Names, 
Dialog Box Names

These elements appear in initial capital letters.

COMMANDS, 
DIRECTORY NAMES, 
and DRIVE NAMES

These elements appear in upper case.

NOTE:  UNIX commands are case sensitive and will not 
appear in uppercase.

Type When you are instructed to type information, type the 
information without pressing the Enter key.

Enter When you are instructed to enter information, type the 
information and then press the Enter key.
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Symbols in Text
These symbols may be found in the text of this guide. They have the following meanings.

WARNING:  Text set off in this manner indicates that failure to follow directions in the 
warning could result in bodily harm or loss of life.

CAUTION:  Text set off in this manner indicates that failure to follow directions could 
result in damage to equipment or loss of information.

IMPORTANT:  Text set off in this manner presents clarifying information or specific instructions.

NOTE:  Text set off in this manner presents commentary, sidelights, or interesting points of 
information.

Getting Help
If you have a problem and have exhausted the information in this guide, you can get 
further information and other help in the following locations.

Compaq Technical Support

In North America, call the Compaq Technical Phone Support Center at 
1-800-OK-COMPAQ. This service is available 24 hours a day, 7 days a week.

NOTE:  For continuous quality improvement, calls may be recorded or monitored.

Outside North America, call the nearest Compaq Technical Phone Support Center. 
Telephone numbers for worldwide Technical Support Centers are listed on the Compaq 
Website. Access the Compaq Website by logging on to the Internet at 
http://www.compaq.com.

http://www.compaq.com
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Be sure to have the following information available before you call Compaq:

■ Technical support registration number (if applicable)

■ Product serial numbers

■ Product model names and numbers

■ Applicable error messages

■ Add-on boards or hardware

■ Third-party hardware or software

■ Operating system type and revision level

■ Detailed, specific questions

Compaq Website

The Compaq Website has the latest information on this product as well as the latest 
drivers. You can access the Compaq Website by logging on to the Internet at 
http://www.compaq.com/storage.

Compaq Authorized Reseller

For the name of your nearest Compaq Authorized Reseller:

■ In the United States, call 1-800-345-1518.

■ In Canada, call 1-800-263-5868.

■ Elsewhere, see the Compaq Website for locations and telephone numbers.

http://www.compaq.com/storage


Chapter 1
Introducing Fabric Manager

Fabric Manager provides a Graphical User Interface (GUI) that allows the administrator to 
monitor and manage SAN Integrated Switches and their individual switch elements.

This chapter provides the following information:

■ Overview, page 1-1

■ Views Available in Fabric Manager, page 1-3

Overview
Fabric Manager provides a GUI that allows the administrator to monitor and manage a 
SAN Integrated Switch from a standard workstation. Fabric Manager can be used to a 
manage fabric containing multiple SAN Integrated Switches. The six switch elements in a 
SAN Integrated Switch are represented as a single entity.

Fabric Manager provides high-level information about all SAN Integrated Switches, as 
well as a view of all other Fibre Channel SAN Switches in the fabric. Fabric Manager 
launches into the Web Management Tools application when more detailed information is 
required for an individual SAN switch or switch element. The launching of Web 
Management Tools is transparent, providing a seamless user interface. In addition to 
viewing the switch elements in a SAN Integrated Switch as a single entity, Fabric 
Manager provides improved performance of the SAN Integrated Switch over Web 
Management Tools alone. 

IMPORTANT:  If Web Management Tools is launched directly, rather than through Fabric Manager, 
switch elements in the SAN Integrated Switch are represented as six individual switches. 
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Fabric Manager is installed on a workstation, and can be used to manage any SAN 
Integrated Switches that have firmware version 2.4 or later installed. All switch elements 
in the SAN Integrated Switch are represented in the main window of Fabric Manager 
(Figure 3–2, Page 3-3).

NOTE:  All switches in the Fabric must have the same version of firmware installed.

Fabric Manager provides:

■ Aggregate monitoring and management of SAN Integrated Switches:

❏ The aggregate status of the six switch elements in the SAN Integrated Switch.

❏ Access to detailed information for each switch element in the SAN Integrated 
Switch.

■ Monitoring and management of all the Fibre Channel SAN switches in the fabric.

❏ The status of all switches in the fabric.

❏ Access to event logs for all switches.

❏ Zoning functions.

❏ Loop diagnostics and query and control of loop interfaces to aid in locating faulty 
devices.

❏ Ability to name and zone QuickLoops.

❏ Access to the Name Server Table.

❏ Telnet functions.

❏ Switch beaconing for rapid identification in large fabric environments.

From Fabric Manager, you can seamlessly view detail-level information including: 

■ Monitoring and management of individual switches in the fabric:

❏ Summary information about each switch.

❏ Access to event logs for individual switches.

❏ Switch configuration and administration.

❏ Ability to upgrade Fabric OS and license key administration.

❏ Report capability for switch configuration information.
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■ Monitoring and management of individual switch ports:

❏ Port status.

❏ Information about Gigabit Interface Converter (GBIC) Serial IDs.

❏ Information about connected devices.

❏ Loop information.

❏ Port performance including frame counts (frames in, frames out) and error counts.

Views Available in Fabric Manager
Fabric Manager provides information about and access to the SAN Integrated Switch 
through a series of separate windows, making it possible to view several aspects of the 
fabric at the same time. Table 1–1 lists a summary of the views available in Fabric 
Manager.

Table 1–1:  Fabric Manager Views  
Initial Display When Fabric Manager is Launched

Fabric View Includes a control panel that provides access to fabric-wide options, a panel for 
each switch in the fabric, plus a legend that explains the meaning of the 
background colors on the switch icons. 

Each panel contains an icon that represents a switch or SAN Integrated Switch, 
in addition to icons for Switch Events and the Administrative and Telnet 
interfaces. The background color of the switch icon represents the status of a 
particular switch, switch element or SAN Integrated Switch (as defined by the 
legend provided in the window). Fabric View also provides access to fabric-wide 
options such as zoning via Web Management Tools.

Switch status is calculated approximately once per second; however, the initial 
calculation does not occur until 30 to 60 seconds after the switch is started. For 
any status based on errors per time interval, any errors will cause the status to 
show faulty until the entire sample interval has passed.
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Accessible from the Fabric View

Fabric Events View Displays the error log for the fabric, which is the combination of the error logs of 
all the switches in the fabric. Accessed by clicking the Fabric Events button on 
the control panel.

Fabric Topology View Displays physical configuration, including active domains, paths, and routing 
information of switches in the SAN. Accessed by clicking the Fabric Topology 
button on the control panel.

Name Server Table 
View

Displays the Name Server Table for the fabric. Use to view information about the 
devices attached to the fabric. Accessed by clicking the Name Server button on 
the control panel.

Zone Administration 
View

Provides an interface to Zoning, including zone settings, zone aliases, 
QuickLoops, and zone configurations. Accessed by clicking the Zone Admin 
button on the control panel.

Fabric Manager Log Provides a record of system events and error messages.

Summary View/ 
Detail View

Toggles between summarized and detailed versions of Fabric View.

SAN Integrated 
Switch Information

Displays a panel for each SAN Integrated Switch, with the status of each switch 
element indicated by the background color of the corresponding switch element 
icon. The detailed information provided corresponds to whatever switch is 
currently selected. 

This view is accessed from Fabric View by clicking the SAN Integrated Switch 
icon on the SAN Integrated Switch panel. Once the SAN Integrated Switch View 
is launched, switch element views for the individual switches in the SAN 
Integrated Switch can be accessed by clicking individual switch element icons.

Switch Information Displays information about individual switches, including a real-time view of 
switch status. Accessed by clicking a switch icon in the SAN Integrated Switch 
View or in Fabric View. The Switch View is also the launch point for the Switch 
Events View, Telnet Interface, Fabric Watch View, Administrative Interface, 
Performance View, and Port Information View. It includes icons that display the 
status of the switch fans, temperature monitors, and beacon. 

Switch Events View Displays the error log for the switch. Accessed by clicking the Events icon on the 
switch panel. This view can also be accessed through Switch View.

Administrative 
Interface

Provides an interface for performing functions such as upgrading firmware 
versions or reconfiguring a switch. Accessed by clicking the Admin icon on the 
switch panel. This view can also be accessed through Switch View.

Table 1–1:  Fabric Manager Views (Continued) 
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NOTE:  Switch View and its associated subviews can be accessed by clicking on any switch or 
switch element in Fabric Views or SAN Integrated Switch View. See Managing the Switch with 
Web Management Tools in the Compaq StorageWorks Fibre Channel SAN Switch Management 
Guide for detailed information on this view.

Telnet Interface Provides an interface for using Telnet commands for switch diagnostics, 
troubleshooting, and fabric management. Accessed by clicking the Telnet icon 
on the switch panel. This view can also be accessed through Switch View.

Accessible From the SAN Integrated Switch View

SAN Integrated 
Switch – Individual 
Switch View

Displays information about an individual switch element in the SAN Integrated 
Switch, including a real-time view of switch status. Accessed by clicking the 
switch element icon from within the SAN Integrated Switch View. This view is 
also the launch point for the Switch Events View, Telnet Interface, Fabric Watch 
View, Administrative Interface, Performance View, and Port Information View. It 
includes icons that display the status of the switch fans, temperature monitors, 
and beacon.

Table 1–1:  Fabric Manager Views (Continued) 





Chapter 2
Installing Fabric Manager

This chapter provides the following information:

■ Requirements, page 2-1

■ Installing, Configuring, and Connecting to Fabric Manager, page 2-3

■ Launching Fabric Manager, page 2-10

■ Adding the Browser Pathname to the Properties File, page 2-12

■ Uninstalling Fabric Manager, page 2-12 

Requirements
The computer workstation and the switch must both meet the following specific 
requirements for the correct installation and operation of Fabric Manager.

Switch Requirements

Fabric Manager can be used to manage or provide access to Compaq StorageWorks Fibre 
Channel SAN switches that meet the following requirements: 

■ Fibre Channel SAN Switch models 8, 16, 8-EL, 16-EL, IS/32, and IS/64.

■ Firmware version 2.4 or later. 

■ Six unused IP addresses, one for each switch element

■ Six Ethernet cables for connecting between the workstation and the SAN Integrated 
Switch (through a router, hub or concentrator). See Figure 2–1.
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Figure 2–1:  Managing the SAN Integrated Switch with Fabric Manager

Workstation Requirements

The following items are required for the correct installation and operation of Fabric 
Manager on the computer workstation: 

■ One of the following operating systems:

❏ Windows 2000

❏ Windows NT 4.0

■ Adequate RAM:

❏ 128 MB for fabrics containing 21 or fewer switches

❏ 256 MB for fabrics containing more than 21 switches

■ 10 MB of free disk space

■ One of the following Web browsers: 

❏ Internet Explorer 4.01 or later

❏ Netscape Communicator 4.51 or later

NOTE:  The browser must be specifically configured to work with Fabric Manager. For 
information about how to do this, see Configuring the Web Browser, page 2-3.

■ Java Plug-in version 1.3

■ One Ethernet connection to each SAN Integrated Switch element (via a router, hub or 
concentrator)

1 RJ-45 Ethernet ports in each 
switch element for 
management through Fabric 
Manager

2 Ethernet cables attached to 
each switch element

3 Representation of a LAN

4 Workstation running Fabric 
Manager

NOTE:  Only one cable is shown for 
the sake of simplicity. In reality, 
each switch element would have a 
cable attached to its RJ-45 
Ethernet port.

SHR-2204A

1

2
3

4
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Installing, Configuring, and Connecting to 
Fabric Manager

Preparing to use Fabric Manager to manage your fabric requires the following steps:

■ Connecting the Ethernet Cables, page 2-3

■ Installing a Web Browser, page 2-3

■ Configuring the Web Browser, page 2-3

■ Installing the Java Plug-in on the Workstation, page 2-5

■ Installing Fabric Manager on the Workstation, page 2-6

Connecting the Ethernet Cables

In order to manage the SAN Integrated Switch through Fabric Manager, each switch 
element must have a valid Ethernet IP address. To configure the IP addresses and connect 
the Ethernet cables, refer to the Compaq StorageWorks SAN Switch Integrated/32 and 
Integrated/64 Installation and Hardware Guide.

Installing a Web Browser

Install one of the following browsers, if not already installed.

1. Internet Explorer 4.01 or later (available at http://www.microsoft.com).

2. Netscape Communicator 4.51 or later (available at http://www.netscape.com/).

Configuring the Web Browser

Specific browser settings are required for the correct operation of Fabric Manager with 
either Internet Explorer or Netscape Communicator.

Configuring Internet Explorer

Correct operation of Fabric Manager with Internet Explorer requires clearing the Web 
browser cache after installation and specifying the appropriate settings for the browser 
refresh frequency and process model.

http://www.netscape.com/
http://www.microsoft.com
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The browser cache must be cleared after the installation of the firmware. The browser may 
use local cache copies of jar files and/or image files to improve performance (depending 
on options selected in the browser), which can cause incorrect display. To remove cached 
files from Internet Explorer.

1. Select Internet Options from the View menu if using Internet Explorer 4.x, or from the 
Tools menu if using 5.x.

2. Select the General tab.

3. Click Delete Files... (under Temporary Internet Files). 

4. Click OK.

5. Exit and relaunch the browser.

Browser pages must be refreshed at every visit to ensure the correct operation of the 
Switch Admin feature. To set the refresh frequency:

1. Select Internet Options from the View menu if using Internet Explorer 4.x, or from the 
Tools menu if using 5.x.

2. Select the General tab and click Settings (under Temporary Internet Files). 

3. Under “Check for newer versions of stored pages,” select “Every visit to the page.”

4. Click OK.

For Windows NT, the correct Browser Process Model must be selected. To select the 
Browser Process Model:

1. Select Internet Options from the View menu if using Internet Explorer 4.x, or from the 
Tools menu if using 5.x.

2. Select the Advanced tab and click to expand the Browsing category.

3. Under Browsing, select “Browse in a new process” if using Internet Explorer 4.x. 
Select “Launch browser windows in a separate process” if using Internet Explorer 5.x. 

Configuring Netscape Communicator

The Web browser cache must be cleared after the installation of the firmware. Use these 
step to remove cached files from Netscape Communicator.

1. Select Edit > Preferences. 

2. Click Advanced in the left text box to expand it, then click Cache.

3. On the Cache panel, click Clear Memory Cache.

4. Click Clear Disk Cache.
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5. Click OK.

6. Exit and launch the browser again.

Installing the Java Plug-in on the Workstation

A Java Plug-in must be installed on the workstation for the Fabric Manager installer to 
function. Windows 2000 and Windows NT workstations require Java Plug-in version 1.3. 

The software eliminates differences between the two supported Web browsers: Netscape 
Navigator and Microsoft Internet Explorer. The Java Plug-in software allows Java applets 
used by the Fabric Manager program to run using Sun's Java Runtime Environment (JRE), 
instead of the browser's default Java virtual machine. The JRE provides consistency and 
reliability when running applets. Java Plug-in works on other operating systems. For more 
information about Java Plug-in support for other operating systems, refer to the manual 
that came with your operating system. For more information on Java Plug-in, go to:

http://java.sun.com/products/plugin/index.html

Checking the Version of the Java Plug-in

Use these steps to check the Java Plug-in version installed.

1. Look on the Add/Remove Programs list:

a. Go to the Start menu, choose Start > Settings > Control Panel > Add/Remove 
Programs.

b. Double-click the Add/Remove Programs folder.

c. Scroll down to the Java file. The version number will show at the end of the file 
name. For example: 

Java 2 Runtime Environment Standard Edition v1.2.2 or 
Java 2 Runtime Environment Standard Edition v1.3.0_02

http://java.sun.com/products/plugin/index.html
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2. Follow step a, b, or c depending on the Java Plug-in version is installed. 

a. If the correct version is installed, Fabric Manager is ready for use. Windows 2000 
and Windows NT workstations require Java Plug-in version 1.3.

b. If an outdated version is currently installed, uninstall it using the Add/Remove. 
Programs feature from your control panel, and follow the instructions for Installing 
the Java Plug-in on Windows, page 2-6.

c. If no Java Plug-in is installed, install the plug-in by following the instructions for 
Installing the Java Plug-in on Windows, page 2-6.

Installing the Java Plug-in on Windows

To install the Java Plug-in on Windows 2000, or NT:

1. Insert the Fabric Manager CD into your CD-ROM drive.

2. Go to the JRE directory.

3. Locate the Java Plug-in .exe file, and double-click.

4. Follow the instruction provided during the installation.

Installing Fabric Manager on the Workstation

To install Fabric Manager:

1. Insert the Fabric Manager CD-ROM in the CD drive of the computer workstation. The 
installer automatically launches.

NOTE:  If Fabric Manager does not automatically launch from the CD-ROM, click setup.exe from 
the list of files on the Fabric Manager CD-ROM.

If Fabric Manager is already installed on the computer, a window displays at this point 
to indicate this. If this window displays, you can either exit the installer and uninstall 
the existing version, or click Next to continue with the installation.

NOTE:  If you decide to continue with the installation and select the same location, all the 
existing files are overwritten, except for the FabricManager.Properties file. The 
FabricManager.Properties file contains the selections from the previous installation, and is 
saved as FabricManager.Properties.old. 
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The Welcome window displays, providing product information and version.

Figure 2–2:  Fabric Manager Welcome window 

2. Click Next. The installer searches the local system for the correct version of the Java 
Plug-in. 

■ If the correct version is not installed, a window displays a warning that the correct version 
of the plug-in is missing. If the installer warns that the plug-in is missing, perform Step 3, 
below, before continuing. 

■ If the correct version is installed, the installation will proceed with Step 4.

3. If the installer warns that the Java Plug-in is missing:

a. Click Exit to close the Fabric Manager installer, then click Exit Install in the 
warning dialog that displays.

b. View the local drives, right-click on the icon for the Fabric Manager CD-ROM, and 
select Explore. 

c. Click to open the JRE folder, then click on the .exe file.

d. The plug-in installer launches.

e. Read the license agreement, and click Next if you accept the agreement.

f. A window displays to allow selection of the installation location.

g. Click Next to accept the default installation location, or browse for a custom 
location and then click Next.
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4. The Web Browser Requirements window displays (see Figure 2–3). Determine 
whether a compatible browser is installed. If a compatible browser is not installed, exit 
the Fabric Manager installation, install the browser, and then relaunch the Fabric 
Manager installer. 

Figure 2–3:  Web Browser Requirements window

NOTE:  The browser should be installed before Fabric Manager is installed so that the pathname 
for the browser can be written to the FabricManager.Properties file.

5. Click Next to continue. The Select Destination Folder window displays (see 
Figure 2–4).
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Figure 2–4:  Select Destination Folder window

6. Click Install to accept the default installation location, or browse for a custom location 
and then click Install.

Once Install is clicked, a window showing the progress of the installation displays, 
with the name of the file currently being installed in the lower portion of the window. 

The installer searches the registry for the Web browser and adds the complete 
pathname to the FabricManager.Properties file. If the installer is unable to locate a 
Web browser, a window displays warning that no browser was found. If this window 
displays, exit the Fabric Manager installation, install the browser, and then relaunch 
the Fabric Manager installer. 

NOTE:  If the browser is installed or moved after Fabric Manager is installed, see Adding the 
Browser Pathname to the Properties File, page 2-12.

Once the installation of Fabric Manager is complete, the following window displays:
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Figure 2–5:  Install Complete window

7. Select the check box if you want to view the ReadMe file, then click Done to close the 
installer.

NOTE:  Clicking Exit at this point does not undo the installation, but does prevent the ReadMe 
file from being displayed, even if the View Readme checkbox is selected.

Launching Fabric Manager
You can launch Fabric Manager once Fabric Manager, the Java Plug-in, and a Web 
browser are installed on the workstation, and a Web Management Tools license is installed 
on the switch.

To launch Fabric Manager:

1. Select Start > Programs > Fabric Manager > Fabric Manager. The URL window 
displays (see Figure 2–6). 

NOTE:  You can resize the URL window to save screen space. Next time you open Fabric 
Manager, the new size will display.
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Figure 2–6:  URL Window

2. Enter the switch name or IP address in the Switch URL field. 

NOTE:  If you want information specific to QuickLoop to be available, the QuickLoop switch must 
be the local domain. The Local domain is the switch IP address which you specify in the URL 
window.

3. Click Add to add the address or switch name in the Switch URL field to the drop-down 
list. To remove an address from the drop-down list, select that address and click Del.

4. Press the Enter key to submit the address.

NOTE:  If an incorrect address or format is used, an error message displays. If an error message 
displays, determine and enter the correct address.

Figure 2–7:  Address Error dialog box

Once a correct address is entered, Fabric Manager launches. The default view (Fabric 
View) displays. For more information about using Fabric Manager, see Using Fabric 
Manager, page 3-1.
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Adding the Browser Pathname to the 
Properties File

If the browser is installed after Fabric Manager is installed, the properties file must be 
edited to show the correct path for the browser. 

NOTE:  Editing any information other than the browser pathname in the properties file is not 
recommended.

To add the browser pathname to the properties file:

1. Open the directory where Fabric Manager is installed. The default directory is 
C:\Program Files\Fabric Manager\ , where “C” is the local drive.

2. Double-click on the FabricManager.Properties file, and select a text editor (such as 
Notepad) as the application for this file.

3. Enter a new line starting with BrowserPath=“xxx”, where “xxx” (in quotes) is the correct 
pathname for the browser. For example:

BrowserPath=“C:\\Program Files\\Internet Explorer\\iexplore.exe”

This line can be added anywhere in the file, provided it does not interrupt another line.

Uninstalling Fabric Manager
NOTE:  The uninstaller can access only the most recent installation. To uninstall an additional 
installation, open the corresponding installation folder, open the subdirectory UninstallerData, 
and double-click Uninstall FabricManager.exe to launch the uninstaller.

To uninstall Fabric Manager:

1. Select Start > Settings > Control Panel.

2. Double-click Add/Remove Programs.

3. On the Install/Uninstall tab of the Add/Remove Programs Properties window, select 
Fabric Manager and click Add/Remove. A window displays warning that you are 
about to uninstall Fabric Manager.

4. Click Uninstall to continue.

5. A window showing the progress of the program removal displays. When the removal is 
complete, the Uninstall Complete window displays.

6. Click Exit to close the Uninstall Complete window.



Chapter 3
Using Fabric Manager

This chapter describes the views and interfaces available through Fabric Manager. The 
first view that displays is Fabric View which provides a gateway to all the other views. The 
sections of Fabric View consist of the following:

■ Control Panel and Associated Views, page 3-8

■ SAN Integrated Switch Panel and Associated View, page 3-10

■ Individual Switch Panel and Associated Views, page 3-12

Switch elements in the SAN Integrated Switch can be accessed simultaneously from 
different connections and by different methods, such as Telnet, SNMP, and through Web 
Management Tools. To ensure that any modifications are correctly applied, verify that the 
switch is being modified from any other connection at the same time.

Fabric View
Fabric View is the first view that displays when you connect to a SAN Integrated Switch 
through Fabric Manager. Fabric View provides access to specific information about the 
switches in the fabric through a panel representing each standalone switch and each SAN 
Integrated Switch. It also provides a control panel and a legend explaining the colors that 
are used to indicate status on the switch panels.



3–2 Fabric Manager for the Fibre Channel SAN Switch Integrated/32 and Integrated/64, Version 1.0

To launch Fabric Manager and access Fabric View:

1. Select Start > Programs > Fabric Manager > Fabric Manager. The URL window 
displays (see Figure 3–1).

Figure 3–1:  URL Window

2. Enter the switch name or IP address in the Switch URL field. 

NOTE:  If you want information specific to QuickLoop to be available, the QuickLoop switch must 
be the local domain. The Local domain is the switch IP address which you specify in the URL 
window.

3. Click Add to add the address or switch name in the Switch URL field to the drop-down 
list. To remove an address from the drop-down list, select that address and click Del.

4. Press the Enter key to submit the address. Fabric Manager launches, displaying the 
default view, Fabric View (see Figure 3–2).

NOTE:  If an incorrect address or format is used, an error message displays. If an error message 
displays, determine and enter the correct address. Once a correct address is entered, Fabric 
Manager launches. The default view (Fabric View) displays. 
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Figure 3–2:  Fabric View, detail format
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Table 3–1 describes the items visible in Fabric View in Detail format. See Figure 3–3 to 
see Fabric View in Summary format.

Table 3–1:  Fabric View Objects  
Object Description

Control Panel and Associated Views

Control Panel Provides access to a number of fabric-wide features and includes a 
legend for interpreting the background color of the Switch icons.

The components of the Control Panel are described in the following 
rows:

■ Fabric Events button

■ Fabric Topology button

■ Name Server button

■ Zone Admin button

■ Summary/Detail View button

■ Fabric Log button

■ Status Legend

Fabric Events button Click to open Fabric Events View. For information about this view, see 
Fabric Events View, page 3-9.

Fabric Topology button Click to open Fabric Topology View. For information about this view, 
see Fabric Topology View, page 3-9.

Name Server button Click to open Name Server Table View. For information about this 
view, see Name Server Table View, page 3-9.

Zone Admin button Click to open Zone Administration View. For information about this 
view, see Zone Administration View, page 3-9.
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Summary/Detail View button Toggle to view Fabric View in either Summary or Detail format. The 
Summary format shows switch panels with abbreviated information 
(see Figure 3–3, page 3-8). The default view is Detail.

Fabric Log button Click to view the messages in the Fabric Manager Log. For 
information about this view, see Fabric Manager Log, page 3-10. 

Status Legend Defines meaning of colors visible in the background of the switch 
icons. Each color indicates a different operational state.

Green Healthy

Yellow Marginal (mix of good and faulty readings)

Red Down (more than two faulty readings)

Gray Unknown or unmonitored

If no data is available from a switch, the most recent background 
color remains displayed. 

NOTE:  For all status readings that are based on errors 
per time interval, any errors will cause the status to 
show faulty until the entire sample interval has passed.

SAN Integrated Switch Panel and Associated Views

SAN Integrated Switch Panel The Switch Panel representing a SAN Integrated Switch. 

The components of the SAN Integrated Switch Panel are described in 
the following rows.

■ SAN Integrated Switch Icon

■ polled at:

■ Name:

■ Type:

SAN Integrated Switch Icon Click to open Group View for the SAN Integrated Switch. The 
background color around the icon indicates the overall status of the 
Integrated Fabric (for information about this view, see Group View for 
the SAN Integrated Switch, page 3-10).

Table 3–1:  Fabric View Objects (Continued) 
Object Description
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polled at: Time of the last status check. 
If the switch is unavailable, this shows the time of the last successful 
status check.

Name: The name of the switch.

Type: Type of SAN Integrated Switch configuration. Types are S64 6 1 
(64-port model), or S32 6 1 (32-port model).

Individual Switch Panel and Associated Views

Individual Switch Panel The Switch Panel representing an individual switch element in the 
fabric. A Switch Panel displays for each individual switch element in 
the fabric. It also displays if an individual switch in the Switch View of 
the SAN Integrated Switch is double-clicked.

The components of the Individual Switch Panel are described in the 
following rows.

■ Individual Switch Icon

■ Events

■ Admin

■ Telnet

■ polled at:

■ Name:

■ Fabric OS version:

■ Domain ID:

■ Ethernet IP:

■ Ethernet Mask:

■ FCnet IP:

■ FCnet Mask:

■ Gateway IP:

■ WWN:

Individual Switch Icon Click to open Switch View for the switch. Each switch type is 
represented by a different icon. The background color around the 
icon indicates the status of the switch (for information about this 
view, see Switch View, page 3-12).

Table 3–1:  Fabric View Objects (Continued) 
Object Description
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Events Click to open Switch Events View to display the Switch Events log (for 
information about this view, see Switch Events View, page 3-13).

Admin Click to open Switch Administration View (for information about this 
view, see Administrative Interface, page 3-13).

Telnet Click to launch the Telnet Interface for the switch (for information 
about this view, see Telnet Interface, page 3-13).

polled at: Time of the last status check 
If the switch is unavailable, this shows the time of the last successful 
status check.

Name: The name assigned to switch

Fabric OS version: The firmware version installed on the selected switch

Domain ID: A number that uniquely identifies the switch within the fabric

Ethernet IP: Ethernet IP address

Ethernet Mask: Ethernet subnetmask

FCnet IP: Fibre Channel IP Address

FCnet Mask: Fibre Channel subnetmask

Gateway IP: Gateway IP address

WWN: Unique numeric identifier for the switch; assigned by manufacturer

Table 3–1:  Fabric View Objects (Continued) 
Object Description



3–8 Fabric Manager for the Fibre Channel SAN Switch Integrated/32 and Integrated/64, Version 1.0

Figure 3–3 shows the Fabric View in Summary format.

Figure 3–3:  Fabric View in Summary Format

Control Panel and Associated Views
Following is a brief description of the views accessible from icons in the Control Panel. 
See “Managing the Switch with Web Management Tools,” in the Compaq StorageWorks 
Fibre Channel SAN Switch Management Guide for detailed information on each of these 
views. The views are:

■ Fabric Events View, page 3-9

■ Fabric Topology View, page 3-9

■ Name Server Table View, page 3-9

■ Zone Administration View, page 3-9

■ Fabric Manager Log, page 3-10
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Fabric Events View

Fabric Events View provides a log of events for all switches in the fabric. See "Managing 
the Switch with Web Management Tools" in the StorageWorks by Compaq Fibre Channel 
SAN Switch Management Guide for detailed information on this view.

Fabric Topology View

Fabric Topology View summarizes the physical configuration of the fabric from the 
perspective of the local domain. The local domain is the domain of the switch entered as a 
URL in the Web browser. 

The Fabric Topology View includes information about the destination domains (which are 
all other domains in the fabric) and the paths between each destination domain and the 
local domain. See "Managing the Switch with Web Management Tools" in the 
StorageWorks by Compaq Fibre Channel SAN Switch Management Guide for detailed 
information on this view.

Name Server Table View

Name Server Table View provides the name server entries listed in the Simple Name 
Server database. This view includes all name server entries for the fabric, not only those 
related to the local domain. Each row in the table represents a different device. See 
"Managing the Switch with Web Management Tools" in the StorageWorks by Compaq 
Fibre Channel SAN Switch Management Guide for detailed information on this view.

Zone Administration View

Zone Administration view provides access to all the zoning functions, and can only be 
accessed using an administrative account. 

NOTE:  This view is not updated once it is launched. If a switch or device is added or removed 
from the network, it is necessary to save the changes and relaunch the Zone Administration 
view for the changes to take effect. 

For more information about using Zoning, see the StorageWorks by Compaq Fibre 
Channel SAN Switch Management Guide, “Understanding and Using Zoning.”
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Fabric Manager Log

The Fabric Manager Log includes system events and error messages. To access the Fabric 
Manager Log 

1. From Fabric View, click the Fabric Log button. 

2. The Fabric Manager Log displays.

Figure 3–4:  Fabric Manager Log

SAN Integrated Switch Panel and 
Associated View

Following is a description of the Group View for the SAN Integrated Switch, accessible 
from the SAN Integrated Switch Panel.

Group View for the SAN Integrated Switch

The SAN Integrated Switch Group View represents all six switch elements in the SAN 
Integrated Switch fabric, and displays when you click a SAN Integrated Switch icon in 
Fabric View. The background color of each Switch icon in this view indicates the status of 
that switch, as close as possible to the real-time status of that switch.

To access the SAN Integrated Switch Group View:

1. From Fabric View, click the SAN Integrated Switch icon. The SAN Integrated Switch 
Group View displays, see Figure 3–5.
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Figure 3–5:  SAN Integrated Switch Group View

2. Click on the switch element icon for which you want to view detailed information. The 
information that displays to the right of the panel is updated for the selected switch. In 
Figure 3–5, information is being displayed for the switch named reg106.

NOTE:  Switch View for an individual switch in the SAN Integrated Switch can be accessed from 
this panel by double-clicking the corresponding Switch icon in SAN Integrated Switch panel.

Table 3–2 lists the information in the SAN Integrated Switch Group View. 

Table 3–2:  SAN Integrated Switch Group View
Field Description

Switch Icons Click to open Switch View for the selected switch. The background color 
around the icon indicates the status of the switch (for information about 
Switch View, see Switch View, page 3-12).

Switch Names (listed above 
the Switch icons)

The name of each switch is listed above the corresponding switch icon.

polled at: The date and time at which the selected switch was last polled.

Name: The name of the selected switch.

Fabric OS version: The firmware version installed on the selected switch.

Domain ID: The domain number of the selected switch; a number that uniquely 
identifies the switch in the fabric.
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Individual Switch Panel and 
Associated Views

The following section describes views accessible from the Individual Switch Panel.

■ Switch View, page 3-12

■ Switch Events View, page 3-13

■ Administrative Interface, page 3-13

■ Telnet Interface, page 3-13

IMPORTANT:  See “Managing the Switch with Web Management Tools” in the StorageWorks by 
Compaq Fibre Channel SAN Switch Management Guide for detailed information on each of the 
following views.

Switch View

Switch View displays when you click a Switch icon in Fabric View or one of the switch 
elements in the Group View for the SAN Integrated Switch (see Figure 3–5). This view 
provides information about the overall status of the switch and the status of the individual 
elements in the switch. The information displayed is as close as possible to a real-time 
view of switch status. If the switch is not functioning properly, a message explains the 
problem detected.

NOTE:  Switch status is calculated approximately once per second; however the initial 
calculation does not occur until 30 to 60 seconds after the switch is started.

Ethernet IP: The Ethernet IP address of the selected switch

Ethernet Mask: The Ethernet mask value of the selected switch

FCnet IP: The Fibre Channel IP address of the selected switch

FCnet Mask: The Fibre Channel net mask value of the selected switch.

Gateway IP: The IP address of default gateway of the selected switch. Must be 
properly set to access switch from other networks.

WWN: Unique numeric assigned by manufacturer.

Table 3–2:  SAN Integrated Switch Group View (Continued)
Field Description
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Switch Events View

Switch Events View displays a log of events for the selected switch.

Administrative Interface

The Administrative Interface provides access to the administrative functions though the 
following tabs:

■ Config Admin tab

■ Firmware Upgrade tab

■ License Admin tab

■ QuickLoop Admin tab

■ Reboot Switch tab

■ SNMP Admin tab

■ Switch Admin tab

■ User Admin tab

Telnet Interface

Each switch can have only one active Telnet session at a time. For a list of Telnet 
commands, see Chapter 4, “Telnet Commands.”

The Telnet Interface requires administrative privileges. Once an administrative login is entered, 
administrative privileges remain available from that workstation until the session is closed and the Web 
browser is exited.





Chapter 4
Fabric Manager Telnet Commands

Fabric Manager Telnet commands provide management support for the Fabric Manager 
application. This section contains information about the following Telnet commands:

■ islTopoCheck, page 4-1

■ islTopoShow, page 4-2

■ sgroupSet, page 4-4

■ sgroupDelete, page 4-5

■ sgroupRename, page 4-6

■ sgroupShow, page 4-7

■ sgroupSupportShow, page 4-8

■ sgroupSwReplace, page 4-11

■ switchStatusPolicySet, page 4-12

■ switchStatusPolicyShow, page 4-15

■ snmpMibCapSet, page 4-16

islTopoCheck

Figure 4–1 shows the islTopoCheck command, which displays the interswitch link (ISL) 
switch group (sgroup) connections and status for this switch. This command is used to 
verify that the switch is properly cabled and configured.

Each port specified in the ISL definition, and the corresponding ISL sgroup for each 
switch member, will be displayed. A switch with properly configured ISL connections 
will report a status of OK for each of these ports.
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Figure 4–1 shows the results of islTopoCheck on a misconfigured switch. In a proper 
configuration, all of the switches would have valid domains and names, and each port 
status would be OK.

Figure 4–1:  islTopoCheck command example

islTopoShow

Figure 4–2 shows the islTopoShow command which displays ISL sgroup topology and 
status. This command is available to all users. The islTopoShow command displays the 
current connections and status for every switch in all ISL sgroups of which the current 
switch is a member. The status for every port and switch combination in each active ISL 
group will be displayed.

This command has the following operand:

sgroup: If the name of a switch group or switch group type is specified in quotes, then 
the command will show the ISL connection status for the specified sgroup or all 
sgroups of the specified type. The default behavior, if no input is provided, is to report 
the topology status for all ISL sgroups of which the current switch is a member.

Figure 4–2 shows the results of islTopoShow on a misconfigured switch. In a proper 
configuration, all of the switches would have valid domains and names, and each port 
status would be OK.

es_6:admin> islTopoCheck
ISL data for type: S32_6_1, sgroup: My_group
idx domain expected wwn name
 01 01 10:00:00:60:69:20:02:9f jr_1003
 02 02 10:00:00:60:69:10:a0:4e es_6
 03 -01 00:00:00:00:00:00:00:03 -UNKNOWN-
 04 -01 00:00:00:00:00:00:00:04 -UNKNOWN-
 05 -01 00:00:00:00:00:00:00:05 -UNKNOWN-
 06 -01 00:00:00:00:00:00:00:06 -UNKNOWN-

Domain: 2, wwn: 10:00:00:60:69:10:a0:4e

 isl port expected switch port actual switch port status
0 08 -> jr_1003 : 00 jr_1003 : 00 OK
1 09 -> jr_1003 : 01 jr_1003 : 01 OK
2 10 -> jr_1003 : 02 jr_1003 : 03 Wrong port
3 11 -> jr_1003 : 03 -UNKNOWN- :-01 Bad status
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Figure 4–2:  islTopoShow command example

es_6:admin> islTopoShow

ISL data for type: S32_6_1, sgroup: My_group

idx domain expected wwn name
01 01 10:00:00:60:69:20:02:9f jr_1003
02 02 10:00:00:60:69:10:a0:4e es_6
03 -01 00:00:00:00:00:00:00:03 -UNKNOWN-
04 -01 00:00:00:00:00:00:00:04 -UNKNOWN-
05 -01 00:00:00:00:00:00:00:05 -UNKNOWN-
06 -01 00:00:00:00:00:00:00:06 -UNKNOWN-

Switch idx: 1 Domain: 1, wwn: 10:00:00:60:69:20:02:9f

isl port expected switch port actual switch port status
0 00 -> es_6 : 08 es_6 : 08 OK
1 01 -> es_6 : 09 es_6 : 09 OK
2 02 -> es_6 : 10 -UNKNOWN- :-01 No record
3 03 -> es_6 : 11 es_6 : 10 Wrong port
4 04 -> -UNKNOWN- : 08 -UNKNOWN- :-01 No record
5 05 -> -UNKNOWN- : 09 -UNKNOWN- :-01 No record
6 06 -> -UNKNOWN- : 10 -UNKNOWN- :-01 No record
7 07 -> -UNKNOWN- : 11 es_6 : 13 Wrong switch
8 08 -> -UNKNOWN- : 08 -UNKNOWN- -01 No record
9 09 -> -UNKNOWN- : 09 -UNKNOWN- -01 No record
10 10 -> -UNKNOWN- : 10 -UNKNOWN- :-01 No record
11 11 -> -UNKNOWN- : 11 -UNKNOWN- :-01 No record
12 12 -> -UNKNOWN- : 08 -UNKNOWN- :-01 No record
13 13 -> -UNKNOWN- : 09 -UNKNOWN- :-01 No record
14 14 -> -UNKNOWN- : 10 -UNKNOWN- :-01 No record
15 15 -> -UNKNOWN- : 11 -UNKNOWN- :-01 No record

Switch idx: 2 Domain: 2, wwn: 10:00:00:60:69:10:a0:4e

isl port expected switch port actual switch port status
0 08 -> jr_1003 : 00 jr_1003 : 00 OK
1 09 -> jr_1003 : 01 jr_1003 : 01 OK
2 10 -> jr_1003 : 02 jr_1003 : 03 Wrong port
3 11 -> jr_1003 : 03 -UNKNOWN- :-01 No record
4 12 -> -UNKNOWN- : 12 -UNKNOWN- :-01 No record
5 13 -> -UNKNOWN- : 13 jr_1003 : 07 Wrong switch
6 14 -> -UNKNOWN- : 14 -UNKNOWN- :-01 No record
7 15 -> -UNKNOWN- : 15 -UNKNOWN- :-01 No record
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sgroupSet

Figure 4–3 shows the sgroupSet command, which enables you to create a switch group. A 
switch group is a combination of six switch elements with common parameters, 
interconnected with ISLs, which acts as a single, high-port count switch. If any parameter 
is not specified, the session will become an interactive session for which all the parameters 
will be prompted.

This command has the following operands:

NOTE:  When entering the information in an interactive session, do not type quotation marks. 

■ sgType: Specify a character string in quotation marks containing the sgroup type, for 
example “S32_6_1”. The given type MUST be a valid type. If the type is not valid, this 
command will be rejected. Valid types are displayed when this command is run 
interactively.

■ sgName: Specify a character string in quotation marks containing the sgroup name, for 
example “FirstGroup”. The given name must have from 1 to 32 characters, comprised 
of letters, digits or underscores. Spaces are not allowed. 

■ sgMemberList: Specify a character string in quotation marks containing the sgroup 
members, for example “1,2,3,4,5,6”. This list can be either the WWN format or 
domain ID format. If given in domain ID format, the list will be validated first to 
ensure that all the specified switch domains are valid. If given in WWN format, a 
warning message may appear if any WWN given is not in the current fabric.

WWN format:
“aa:bb:cc:dd:ee:ff:xx:yy,aa:bb:cc:dd:ee:ff:xx:zz,
aa:bb:cc:dd:ee:ff:xx:ww,...,aa:bb:cc:dd:ee:ff:xx:qq”

Domain ID format:
“domain_ID1,domain_ID2,...,domain_IDx”

To set a group called “My Group” of type “S32_6_1” using domain IDs 1 through 6, see 
Figure 4–3.

Figure 4–3:  sgroupSet command example

sw:admin> sgroupSet “S32_6_1”, “MyGroup”, “1,2,3,4,5,6”

Committing configuration...done.
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Figure 4–4 shows the interactive form of sgroupSet:

Figure 4–4:  Interactive form of sgroupSet

sgroupDelete

Figure 4–5 shows the sgroupDelete command, which enables you to delete a switch group. 
If the parameter is not specified, the command will become an interactive session and the 
necessary parameters will be prompted. 

This command makes the same change to all switches in the specified group. It executes 
on every switch in the group if, and only if, each switch in the group can perform the 
action.

This command has the following operands:

NOTE:  When entering the information in an interactive session, do not type quotation marks. 

sw:admin> sgroupSet

Here are the valid sgroup types:

S32_6_1

      Please Enter Group Type: [S32_6_1] S32_6_1

      Please Enter Group Name: [ ] MyGroup   

      Enter member list by domain#? (yes, y, no, n): [yes] n

      For Group Member #1

      enter its WWN (in hex): [00:00:00:00:00:00:00:00] 10:00:00:60:69:00:00:20

      For Group Member #2

      enter its WWN (in hex): [00:00:00:00:00:00:00:00] 10:00:00:60:69:20:15:81

      For Group Member #3

      enter its WWN (in hex): [00:00:00:00:00:00:00:00] 10:00:00:60:69:10:02:18

      For Group Member #4

      enter its WWN (in hex): [00:00:00:00:00:00:00:00] 10:00:00:60:69:20:15:71

      For Group Member #5

      enter its WWN (in hex): [00:00:00:00:00:00:00:00] 10:00:00:60:69:00:30:05

      For Group Member #6

      enter its WWN (in hex): [00:00:00:00:00:00:00:00] 10:00:00:60:69:00:60:11

      Committing configuration...done.
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■ sgName: Specify a character string in quotation marks containing the switch group 
name to be deleted (for example “MyGroup”). Entering a wrong name will cause this 
command to terminate without modifying any switch groups. The sgroup name is case 
sensitive.

■ force: Specify the force parameter to delete the group even if one or more members of 
the group failed to execute the command. The entered string must be “force”.

Figure 4–5:  sgroupDelete command, interactive example

Figure 4–6 shows an invalid group:

Figure 4–6:  sgroupDelete, invalid group

sgroupRename

Figure 4–7 shows the sgroupRename command, which enables you to rename a specified 
sgroup name to the given new name. The member list for the renamed group is not 
modified. If any parameter is not specified, the session will become an interactive session 
for which all the parameters will be prompted.

This command has the following operands:

NOTE:  When entering the information in an interactive session, do not type quotation marks. 

■ oldName: Specify a character string in quotation marks containing the sgroup name to 
be replaced, for example “MyPrevGroupName.”

■ newName: Specify a character string in quotation marks containing the new sgroup 
name, for example “MyNewGroupName.”

sw:admin> sgroupDelete

Please Enter Group Name: [ ] MyGroup

About to DELETE the group with Group name “MyGroup”

ARE YOU SURE (yes, y, no, n): [no] y

Committing configuration...done.

sw:admin> sgroupDelete “MyPrevGroup”

Group Name “MyPrevGroup” does not exist.
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Figure 4–7 shows a noninteractive session using sgroupRename:

Figure 4–7:  sgroupRename command example

sgroupShow

Figure 4–8 shows the sgroupShow command, which enables you to display switch group 
configuration information. If no parameter is specified, all sgroup definitions will be 
displayed. If a parameter is specified, all sgroups with sgType or sgName that contain the 
given parameter string will be displayed.

The sgroupShow command‘s operands are listed next.

NOTE:  When entering the information in an interactive session, do not type quotation marks. 

■ sgType: Specify a character string in quotation marks containing the sgroup type to be 
displayed, for example “S32_6_1”. This operand must be enclosed in quotation marks.

sw:admin> sgroupShow

Group Type Group Name Member WWN

========== ============================= ==================

S32_6_1 MyPrevGroupName 10:00:00:60:69:00:00:20

10:00:00:60:69:20:15:81

10:00:00:60:69:10:02:18

10:00:00:60:69:20:15:71

10:00:00:60:69:00:30:05

10:00:00:60:69:00:60:11

sw:admin> sgroupRename “MyPrevGroupName”, “MyNewGroupName”

Committing configuration...done.

sw:admin> sgroupShow

Group Type Group Name Member WWN             

========== ============================= ==================

S32_6_1 MyNewGroupName 10:00:00:60:69:00:00:20

10:00:00:60:69:20:15:81

10:00:00:60:69:10:02:18

10:00:00:60:69:20:15:71

10:00:00:60:69:00:30:05

10:00:00:60:69:00:60:11
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■ SgName: Specify a character string in quotation marks containing the sgroup name to 
be displayed, for example “Group.” If no parameter is specified, all defined sgroups 
will be displayed. This operand must be enclosed in quotation marks.

Figure 4–8 displays all switch group configurations:

Figure 4–8:  sgroupShow command example

sgroupSupportShow

Figure 4–9 shows the sgroupSupportShow command, which displays switch information for 
all switches within the specified group. This command can display a range of debugging 
information for all the switches in a switch group. If no commandName is specified or all is 
specified in place of a command name, all the supported commands are displayed for the 
all the switches within a switch group. If a single command is specified, only the 
information for that command is displayed.

sw:admin> sgroupShow

Group Type Group Name Member WWN

========== ========================= =======================

S32_6_1 MyNewGroupName 10:00:00:60:69:00:00:20

10:00:00:60:69:10:62:ee

10:00:00:60:69:10:61:0e

10:00:00:60:69:10:60:f9

10:00:00:60:69:10:62:44

10:00:00:60:69:10:60:a0

sw:admin> sgroupShow “Group”

Group Type Group Name Member WWN

========== ============================== ===================

S32_6_1  MyNewGroupName 10:00:00:60:69:00:00:20

10:00:00:60:69:20:15:81

10:00:00:60:69:10:02:18

10:00:00:60:69:20:15:71

10:00:00:60:69:00:30:05

10:00:00:60:69:00:60:11
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sgroupSupportShow operands are listed next.

NOTE:  When entering the information in an interactive session, do not type quotation marks. 

■ sgroupName: Specify the name of the switch group. This operand must be enclosed in 
quotation marks. This operand is required.

■ commandName: Specify the name of the command to be displayed for the specified 
switch group. If no command is specified, or all is specified, all the supported 
commands are executed against all the switches within a switch group. Below is a list 
of command names that are supported in the order they are executed. These command 
names are not case-sensitive. Enclose operands in quotation marks. 

❏ version
❏ uptime
❏ tempShow
❏ psShow
❏ licenseShow
❏ diagShow
❏ errDump
❏ switchShow
❏ portFlagsShow
❏ portErrShow
❏ mqShow
❏ portSemShow
❏ portShow
❏ portRegShow
❏ portRouteShow
❏ fabricShow
❏ topologyShow
❏ qlShow
❏ nsShow
❏ nsAllShow
❏ cfgShow
❏ configShow
❏ faultShow
❏ traceShow
❏ portLogDump
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Figure 4–9 shows how to display the temperature in all the switch elements of a SAN 
Integrated Switch.

Figure 4–9:  sgroupSupportShow command example

sw5:admin>sgroupsupportshow “starbase”, “tempshow”
Group Type Group Name Member WWN
========================================
S32_6_1 starbase 10:00:00:60:69:10:57:91

10:00:00:60:69:10:56:79
10:00:00:60:69:10:58:89
10:00:00:60:69:10:57:dd
10:00:00:60:69:10:58:63
10:00:00:60:69:10:58:3f

Please wait for remote data!
value = 0
star7:root>
========================================
Information from Local Domain 7
========================================
27 30 31 33 32 Centigrade
80 86 87 91 89 Fahrenheit
========================================
Information from Domain 8
========================================
28 29 32 33 33 Centigrade
82 84 89 91 91 Fahrenheit
========================================
Information from Domain 9
========================================
27 29 33 34 32 Centigrade
80 84 91 93 89 Fahrenheit
========================================
Information from Domain 10
========================================
 26 30 31 34 31 Centigrade
 78 86 87 93 87 Fahrenheit
========================================
Information from Domain 11
========================================
28 29 31 33 32 Centigrade
82 84 87 91 89 Fahrenheit
========================================
Information from Domain 12
========================================
28 31 34 35 33 Centigrade
82 87 93 95 91  Fahrenheit
====================DONE==================
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sgroupSwReplace

Figure 4–10 shows the sgroupSwReplace command, which enables you to replace a 
member of a switch group. The order of members within the member list will not be 
changed by this operation. If any parameter is not specified, the session will become an 
interactive session and all the parameters will be prompted.

This command makes the same change to all switches in the group. It will execute on 
every switch in the group, as long as each switch in the group can perform the action.

sgroupSwReplace operands are listed next. All operands are optional.

NOTE:  When entering the information in an interactive session, do not type quotation marks. 

■ sgName: Specify the switch group name (for example, “NewGroup”) that contains the 
member you want to replace. The switch group name must be enclosed in quotation 
marks. 

■ oldWwn: Specify the WWN of a switch group member (for example, 
“10:00:00:60:69:20:22:22”) that you want to replace. The WWN must be enclosed in 
quotation marks. 

■ newWwn: Specify the WWN of the new member (for example, 
“10:00:00:60:69:20:55:55”). The WWN must be enclosed in quotation marks. 

Figure 4–10 shows the non-interactive form of sgroupSwReplace. The sgroupShow 
command is used to illustrate the changes made with the sgroupSwReplace command.
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Figure 4–10:  sgroupShow, sgroupSwReplace command examples

switchStatusPolicySet

Figure 4–11 shows the switchStatusPolicySet command, which enables you to set the policy 
parameters that determine the overall switch status. Use this command to set the policy 
parameters for calculating the overall status of the switch enclosure. The policy parameter 
values determine how many failed or faulty units of each contributor are allowed before 
triggering a status change in the switch from HEALTHY to MARGINAL or DOWN.

The command will print the current parameters in a three column table format. The first 
column specifies the contributor; the second column specifies the minimum number that 
contributes to the DOWN/FAILED status; the third column specifies the minimum 

sw:admin> sgroupShow

Group Type Group Name Member WWN

================ ======================= =======================

S32_6_1 NewGroup 10:00:00:60:69:20:15:71

10:00:00:60:69:20:15:93

10:00:00:60:69:20:15:2a

10:00:00:60:69:20:18:32

10:00:00:60:69:20:22:22

10:00:00:60:69:20:64:31

value = 0

sw:admin> sgroupSwReplace “NewGroup”, “10:00:00:60:69:20:22:22”, “10:00:00:60:69:20:55:55”

Committing configuration...done.

sw:admin> sgroupShow

Group Type Group Name Member WWN

================ ======================= =======================

S32_6_1  NewGroup  10:00:00:60:69:20:15:71

10:00:00:60:69:20:15:93

10:00:00:60:69:20:15:2a

10:00:00:60:69:20:18:32

10:00:00:60:69:20:55:55

10:00:00:60:69:20:64:31



Fabric Manager Telnet Commands 4–13

number that contributes to the MARGINAL/WARNING status. This command then 
prompts the user to change the values for each policy parameter. The default values for the 
policy parameters are as follows:

Any single contributor can force the overall status of the switch to MARGINAL or 
DOWN. 

This command enables you to set a threshold for each contributor, so that a certain number 
of failures are allowed before changing the status of the switch.

If the value of a policy parameter is set to 0, it means that this factor is not used to 
determine the status of the switch. If the range of values for a particular contributor are set 
to 0 for both MARGINAL and DOWN, that contributor is not used in the calculation of 
the overall switch status.

ISLStatus monitors ISLs that are part of a defined switch group. The status of other ISLs on 
the same switch but outside of the group definition will not be considered when 
calculating switch status. If no switch groups are defined on this switch, then these 
ISLStatus settings will have no effect on switch status. 

The sgroup ISLStatus does not affect the status of the switch as quickly as the other 
contributors. It may take a few minutes for a switch group ISL status change to affect the 
state of the switch.

NOTE:  When PortStatus monitoring is set to values of (0,0), port status changes are not logged 
to the event log and console. Similarly, GBIC removal does not generate a message to the event 
log and console if MissingGBICs is set to (0,0). By configuring these options, the user can more 
closely monitor for port status and removal of GBICs.

Notice that in Figure 4–11, the only parameters modified are the number of FaultyPorts 
allowed before the status of the switch changes to MARGINAL and DOWN.

Table 4–1:  Default Values for switchStatusPolicySet Parameters
Contributor Default Value for DOWN Default Value for MARGINAL

FaultyPorts 2 1

MissingGBICs 0 0

PowerSupplies 2 1

Temperatures 2 1

Fans 2 1

PortStatus 0 0

sgroup ISLStatus 2 1
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Figure 4–11:  switchStatusPolicySet

switch:admin> switchStatusPolicySet
To change the overall switch status policy parameters
The current overall switch status policy parameters:
Down Marginal

     ----------------------------------

FaultyPorts 1 0

MissingGBICs 0 1

PowerSupplies 2 1

Temperatures 2 1

Fans 2 1

PortStatus 0 0

sgroup ISLStatus 2 1

Note that the value, 0, for a parameter, means that it is NOT used in the calculation.

** In addition, if the range of settable values in the prompt is (0..0),

** the policy parameter is NOT applicable to the switch.

** Simply hit the Return key.

The minimum number of

FaultyPorts contributing to DOWN status: (0..8) [2] 
FaultyPorts contributing to MARGINAL status: (0..8) [1] 
MissingGBICs contributing to DOWN status: (0..8) [0] 
MissingGBICs contributing to MARGINAL status: (0..8) [0] 1
Bad PowerSupplies contributing to DOWN status: (0..2) [2] 
Bad PowerSupplies contributing to MARGINAL status: (0..2) [1] 
Bad Temperatures contributing to DOWN status: (0..5) [2] 
Bad Temperatures contributing to MARGINAL status: (0..5) [1] 
Bad Fans contributing to DOWN status: (0..6) [2] 
Bad Fans contributing to MARGINAL status: (0..6) [1] 
Down PortStatus contributing to DOWN status: (0..8) [0]
Down PortStatus contributing to MARGINAL status: (0..8) [0]
Down ISLStatus contributing to DOWN status: (0..16) [2]
Down ISLStatus contributing to MARGINAL status: (0..16) [1]

Policy parameter set has been changed
... Committing configuration...done.
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switchStatusPolicyShow

Figure 4–12 shows the switchStatusPolicyShow command, which displays the policy 
parameters that determine the overall switch status. Use this command to view the current 
policy parameters set for the switch. These policy parameters determine the number of 
failed or nonoperational units allowed for each contributor before triggering a status 
change in the switch.

The command will print the current parameters in a three column table format. The first 
column specifies the contributor; the second column specifies the minimum number that 
contributes to the DOWN/FAILED status; the third column specifies the minimum 
number that contributes to the MARGINAL/WARNING status. Table 4–2 lists default 
values for the policy parameters.

The policy parameters determine the number of non-operational units for each contributor 
that trigger a status change in the switch. For example, if the FaultyPorts DOWN parameter is 
set to 3, and 3 ports fail in the switch, then the status of the switch changes to DOWN.

Figure 4–12:  switchStatusPolicyShow command example

Table 4–2:  Default Values for switchStatusPolicyShow Parameters
Contributor Default Value for DOWN Default Value for MARGINAL

FaultyPorts 2 1

MissingGBICs 0 0

PowerSupplies 2 1

Temperatures 2 1

Fans 2 1

PortStatus 0 0

sgroup ISLStatus 2 1

switch:admin> switchStatusPolicyShow

The current overall switch status policy parameters:

                     Down    Marginal
     ------------------------------------------

FaultyPorts 1 0

MissingGBICs 0 1

PowerSupplies 2 1

Temperatures 3 1

Fans 3 1

PortStatus 0 0

sgroup ISLStatus 2 1
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snmpMibCapSet

Figure 4–13 shows the snmpMibCapSet command, which enables you to view and modify 
options for configuring SNMP MIB/Trap Capability. This command enables a user to turn 
on or off certain MIBS and TRAPS. This command also enables a user to turn on or off 
group information and SSN in SW trap messages. It first displays current settings and then 
prompts the user to change the values for each parameter.

■ FA-MIB—Specifying yes means the user can access FA MIB variables with an SNMP 
manager. The default value is yes.

■ SW-TRAP—Specifying yes means the SNMP management application can receive 
SW traps from the switch. The default value is yes.

■ FA-TRAP—Specifying yes means the SNMP management application can receive FA 
traps from the switch. The default value is yes.

■ SW-EXTTRAP—Specifying yes means the user can receive group information such 
as Group Name, Group Type, and Member Position, and SSN in the SW traps. The 
default value is no.

Figure 4–13:  snmpMibCapSet

swd55:admin> snmpmibcapset

The SNMP Mib/Trap Capability has been set to support

FE-MIB SW-MIB FA-MIB SW-TRAP FA-TRAP 

FA-MIB (yes, y, no, n): [yes] 

SW-TRAP (yes, y, no, n): [yes] 

FA-TRAP (yes, y, no, n): [yes] 

SW-EXTTRAP (yes, y, no, n): [no] 

no change



Glossary

This glossary defines terms used in this guide or found in the Fabric Manager application, 
and is not a comprehensive glossary of computer terms.

8b/10b encoding

Encoding scheme that converts each 8-bit data byte into a 10-bit transmission character. 
Used to balance ones and zeros in high speed transports.

address identifier

Value used to identify source or destination of a frame.

AL_PA

Arbitrated Loop Physical Address. Unique 8-bit value assigned during loop initialization 
to each port in an arbitrated loop

Alias Server

Fabric software facility that supports multicast group management.

ANSI

American National Standards Institute. Governing body for Fibre Channel standards in the 
U.S.A.

API

Application Programming Interface. Defined protocol that allows applications to interface 
with a set of services.
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Arbitrated loop

A Fibre Channel transport structured as a loop. Allows communication between ports 
without using a switch. Requires successful arbitration by a port before a circuit is 
established. Supports up to 126 devices and one fabric attachment. 

ATM

Asynchronous Transfer Mode. Transport for transmitting data over LANs or WANs that 
transmit fixed-length units of data. Provides any-to-any connectivity and allows nodes to 
transmit simultaneously.

Bandwidth

The total transmission capacity of a link, cable, or system.

BB_Credit

Buffer-to-buffer credit. The number of frames that can be transmitted to a directly 
connected recipient or within an arbitrated loop. Determined by number of available 
receive buffers. See also Buffer-to-Buffer Flow Control, EE_Credit.

BER

Bit Error Rate. Rate at which bits are expected to be received in error. Expressed as ratio 
of error bits to total bits transmitted. See also Error.

Bit Synchronization

The delivery of correctly clocked bits at the required BER. See also BER.

Broadcast

Transmission of data from a single source to all devices in fabric, regardless of zoning. See 
also Multicast, Unicast.

Buffer-to-Buffer Flow Control

Management of frame transmission rate between directly connected ports or within an 
arbitrated loop. See also BB_Credit.

Cascade

Two or more interconnected Fibre Channel switches. 



Glossary g–3

Circuit

Established communication path between ports. Consists of two virtual circuits that 
transmit in opposite directions. See also Link.

Class 1

A connection-oriented service that provides a dedicated connection between two ports, 
with notification of delivery or non-delivery.

Class 2

A multiplex and connectionless frame switching service between two ports, with 
notification of delivery or non-delivery. 

Class 3

A connectionless frame switching service between two ports, without notification of 
delivery or non-delivery. Can also be used to provide a multicast connection between 
originator and recipients, with notification of delivery or non-delivery.

Class F

A service for control traffic between switches, with notification of delivery or non-delivery 
between the E_Ports.

Class of service

A set of specific delivery characteristics and attributes for frame delivery.

Community (SNMP)

Relationship between a group of SNMP managers and an SNMP agent, in which 
authentication, access control, and proxy characteristics are defined.

CRC

Cyclic Redundancy Check. A check for transmission errors; included in every data frame.

Credit

As applies to Fibre Channel, the number of receive buffers available for transmission of 
frames between ports. See also BB_Credit and EE_Credit.
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Cut-through

Switching technique that allows selection of a transmission route for a frame as soon as 
destination address is received. See also Route.

Data word

Type of transmission word that occurs within frames. The frame header, data field, and 
CRC all consist of data words. See also Frame, Ordered set, Transmission Word.

Defined configuration

The complete set of all zone objects defined in the fabric; can include multiple zone 
configurations. See also Enabled configuration, Zone configuration.

Disparity

The relationship of ones and zeros in an encoded character. Neutral disparity indicates an 
equal number of each, positive disparity a majority of ones, and negative disparity a 
majority of zeros.

DLS

Dynamic Load Sharing. Dynamic distribution of traffic over available paths. Allows for 
redistribution when an Fx_Port or E_Port comes up or down.

Domain ID

A unique number between 1 and 239 that identifies the switch to the fabric.

E_D_TOV

Error Detect Time-out Value. Time allowed for round-trip transmission before recovery is 
initiated. Can also be defined as the minimum time an L_Port waits for sequence 
completion before initiating recovery. See also R_A_TOV.

E_Port

Expansion Port. A switch port that has the ability to connect to a similar port on another 
switch, allowing creation of an interswitch link. See also ISL.

EE_Credit

End-to-end credit. The number of receive buffers allocated by recipient port to originating 
port. Used by Class 1 and 2 services to manage exchange of frames across intervening 
ports in fabric. See also End-to-end flow control, BB_Credit.
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Enabled configuration

The currently enabled zone configuration. Only one configuration can be enabled at a 
time. See also Defined configuration, Zone configuration.

End-to-end flow control

Governs flow of Class 1 and 2 frames between N_Ports. See also Buffer-to-Buffer Flow 
Control, EE_Credit.

Error

As applies to Fibre Channel, a missing or corrupted frame, time-out, loss of 
synchronization, or loss of signal. See also BER, Loop failure.

Exchange

As applies to Fibre Channel, a communication session between N_Ports involving the 
transmission of one or more related sequences, in one or both directions. See also 
Sequence.

F_Port

Fabric Port. A port that can transmit using fabric protocol and can interface over links. 
Can be used to connect N_Ports to a switch. See also FL_Port, Fx_Port.

Fabric

A Fibre Channel network of two or more switches. Also called a switched fabric. See also 
SAN, Cascade.

Fabric name

Unique 64-bit identifier assigned to each separate fabric. Communicated during login and 
port discovery.

Fabric OS

Operating system on Compaq Fibre Channel SAN switches.

Fabric Watch

Product that allows monitoring and configuration of fabric and switch elements.
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FC-AL-3

The Fibre Channel Arbitrated Loop standard. Defined on top of FC-PH standards.

FC-FLA

The Fibre Channel Fabric Loop Attach standard.

FCP

Fibre Channel Protocol. Mapping of protocols onto Fibre Channel standard protocols. For 
example, SCSI FCP maps SCSI-3 onto Fibre Channel.

FC-PH-1, 2, 3

The Fibre Channel Physical and Signaling Interface standards.

FC-PI

The Fibre Channel Physical Interface standard.

FC-PLDA

The Fibre Channel Private Loop Direct Attach standard. Applies to operation of peripheral 
devices on private loops.

FC-SW-2

The Fibre Channel Switch Fabric standard, second generation. Specifies tools and 
algorithms for interconnection and initialization of Fibre Channel switches. 

Fibre Channel transport

Protocol service that supports communication between Fibre Channel service providers. 
See also FSP.

FL_Port

Fabric Loop Port. A port that can transmit under both fabric protocol and loop protocol. 
Can be used to connect NL_Ports to a switch. See also F_Port, Fx_Port.

FLOGI

Fabric Login. Process by which a node makes a logical connection to fabric. Used by ports 
to determine if fabric is present, and, if present, to exchange service parameters with the 
fabric. See also PLOGI.
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Frame

Fibre Channel structure used to transmit data. Consists of start-of-frame delimiter, header, 
any optional headers, data payload, cyclic redundancy check (CRC), and end-of-frame 
delimiter. There are two types: data frames and link control frames. Similar to the 
networking concept “packet”. See also Sequence, Data word.

FRU

Field Replaceable Unit. A component that can be replaced on site.

FS

Fibre Channel Service. A service that is defined by Fibre Channel standards and exists at a 
well-known address. For example, Name Server is a Fibre Channel service. See also FSP.

FSP

Fibre Channel Service Protocol. The common protocol used for all fabric services, 
transparent to fabric type or topology. See also FS.

FSPF

Fabric Shortest Path First. Routing protocol for Fibre Channel switches.

Full-duplex

Mode of communication that allows a port to simultaneously transmit and receive frames. 
See also Half-duplex.

Fx_Port

Fabric port that can operate either as F_Port or FL_Port. See also F_Port, FL_Port.

G_Port

Generic Port. Port that can operate either as E_Port or F_Port. Ports are defined as G_Ports 
when disconnected or have not assumed specific function within fabric.

Gateway

IP address assignment that provides translation for incompatible networks. For example, 
ATM gateway can connect a Fibre Channel link to an ATM connection.
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GBIC

Gigabit Interface Converter. Removable serial transceiver module that allows gigabit 
physical-layer transport for Fibre Channel.

Gbps

Gigabits (1,062,500,000 bits) per second.

GBps

Gigabytes (1,062,500,000 bytes) per second.

Half-duplex

Mode of communication that allows a port to either transmit or receive frames, but not 
both at once. The only exception is link control frames, which can be transmitted at any 
time. See also Full-duplex.

Hard address

The AL_PA that an NL_Port attempts to acquire during loop initialization.

HBA

Host Bus Adapter. Interface card between a server or workstation bus and the Fibre 
Channel network. Similar to a network interface card.

Hub

Fibre Channel wiring concentrator that collapses loop topology into physical star 
topology. Nodes are automatically added when active and removed when inactive.

Idle

Continuous transmission of an ordered set when no data is being transmitted to maintain 
an active Fibre Channel link and synchronization.

Initiator

Server or workstation that initiates communications with storage devices over a Fibre 
Channel network. See also Target.
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IOD

In Order Delivery. A parameter that, when set, guarantees that frames are delivered 
in-order if possible, and dropped if not.

ISL

Interswitch Link. Fibre Channel link from the E_Port of one switch to E_Port of another. 

IU

Information Unit. An individual set of information as defined by higher-level process 
protocol definition, or upper-level protocol mapping.

JBOD

Just a Bunch Of Disks. A number of disks connected in a single chassis to one or more 
controllers. See also RAID.

K28.5

Special 10-bit character used to indicate beginning of transmission words that perform 
Fibre Channel control and signaling functions. First seven bits are comma pattern. 

L_Port

Loop Port. Node or fabric port that can use loop protocol or fabric protocol. See also 
Non-participating mode, Participating mode.

Latency

Time required to transmit a frame, from the time sent until time of arrival.

Link

As applies to Fibre Channel, a physical connection between two ports, consisting of both 
transmit and receive fibers. See also Circuit.

Link services

Protocol for link-related actions.

LIP

Loop Initialization Primitive. The signal used to begin initialization in a loop. Indicates 
either loop failure or resetting of a node. See also Loop initialization. 
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Loop failure

Loss of signal within a loop for any period of time, or loss of synchronization for longer 
than the time-out value. See also E_Port.

Loop initialization

Logical procedure used by L_Ports to discover environment. Can be used to assign 
AL_PA addresses, detect loop failure, or reset a node. See also LIP.

Loop_ID

Hex value representing one of 127 possible AL_PA values in a loop. 

Looplet

Set of devices connected in a loop to a port that is part of another loop.

LPSM

Loop Port State Machine. Logical entity that performs arbitrated loop protocols and 
defines behavior of L_Ports when they require access to arbitrated loop.

LWL

Long wavelength fiber optic cable. Based on 1300 nm lasers supporting 1.0625 Gbps link 
speeds. Connectors are color-coded blue. See also SWL.

MIB

Management Information Base. SNMP structure that provides configuration and device 
information to assist with device management.

Multicast

Transmission of data from a single source to a number of specified N_Ports. See also 
Broadcast, Unicast.

Multimode

Fibre-optic cabling specification allowing up to 500 meters between devices.

N_Port

Node Port. Port that can attach to a Fibre Channel port. See also NL_Port, Nx_Port.
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Name server

Service of storing names, addresses, and attributes for up to 15 minutes, provided by a 
switch to other entities in fabric. Defined by Fibre Channel standards, and existing at a 
well-known address. Also called Simple Name Server, SNS, or directory service.

NL_Port

Node Loop Port. An N_Port that can use loop protocol. See also N_Port, Nx_Port.

Node

Fibre Channel entity with one or more N_Ports or NL_Ports.

Node name

Unique identifier for a node, communicated during login and port discovery.

Non-participating mode

Mode in which L_Port is inactive in loop and cannot arbitrate or send frames, but can 
retransmit received transmissions. Port enters mode if there are more than 127 devices in 
loop, and an AL_PA cannot be acquired. See also Participating mode.

Nx_Port

Node port that can operate as either an N_Port or NL_Port.

Ordered set

A type of transmission word that occurs outside of frames, and is used to manage frame 
transport and differentiate Fibre Channel control information from data. See also Data 
word, Transmission Word.

Participating mode

Mode in which an L_Port in a loop has valid AL_PA and can arbitrate, send frames, and 
retransmit received transmissions. See also Non-participating mode.

Phantom device

Device not physically in a loop but logically included by phantom address.

Phantom address

AL_PA value assigned to device not physically in loop. Also called phantom AL_PA.
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PLOGI

Port Login. Port-to-port login process by which initiators establish sessions with targets. 
See also FLOGI.

Point-to-point

Two Fibre Channel devices connected by a direct link. See also Topology.

Port_Name

Unique FC identifier for port, communicated during login and port discovery.

POST

Power On Self Test. Series of self-tests run after a switch is rebooted or reset.

Private NL_Port

NL_Port that does not log into the fabric and communicates only with private NL_Ports in 
same loop.

Private device

Device that supports arbitrated loop protocol and understands 8-bit addresses, but cannot 
log into fabric.

Private loop

An arbitrated loop with no Fibre Channel attachment.

Protocol

A defined method and standards for communication.

Public NL_Port

NL_Port that logs into the fabric, can function within public or private loops, and can 
communicate with public or private NL_Ports.

Public device

Device that supports arbitrated loop protocol, understands 8-bit addresses, and can log into 
fabric.
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Public loop

An arbitrated loop attached to a switch.

QuickLoop

Either the product that allows private devices within loops to communicate over the fabric 
with other devices, or the set of actual devices or looplets connected in a loop by 
QuickLoop technology. 

R_A_TOV

Resource Allocation Time-out Value. Maximum time a frame can be delayed in the fabric 
and still be delivered. See also E_D_TOV, E_Port.

RAID

Redundant Array of Independent Disks. Collection of disk drives that appear as a single 
volume to the server, and are fault-tolerant through mirroring or parity checking. See also 
JBOD.

Remote Switch Services

Product that enables two Compaq Fibre Channel SAN Switches to connect over an ATM 
connection. Requires compatible Fibre Channel-to-ATM gateways. Can be up to 10 
kilometers distance between each switch and respective gateway.

Route

As applies to fabric, a communication path between two switches. See also FSPF.

RSCN

Registered State Change Notification. Switch function that sends notification of fabric 
changes from the switch to specified nodes.

SAN

Storage Area Network. Network of systems and storage devices that usually communicate 
using Fibre Channel protocols. See also Fabric.

Sequence

A Fibre Channel structure containing one or more frames transmitted in a unidirectional 
manner between N_Ports. See also Exchange, Frame.
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Single mode

Fibre-optic cabling standard for distances of up to 10 kilometers between devices.

SNMP

Simple Network Management Protocol. Internet management protocol that does not rely 
on underlying communication protocols and can therefore be made available over other 
protocols, such as UDP/IP. See also Community (SNMP).

SNS

Simple Name Server. See Name server.

Switch

A combination of hardware and firmware that routes frames according to Fibre Channel 
protocol. Switches can have G_Ports, E_Ports, F_Ports, and FL_Ports.

Switch Domain_ID

Unique identifier for a switch, used in routing frames. Usually automatically assigned by 
the switch, but can be manually assigned by administrator.

Switch name

Arbitrary name assigned to switch by administrator. See also Switch Domain_ID.

SWL

Short wavelength fiber-optic cable. Based on 850 nm lasers supporting 1.0625 Gbps link 
speeds. Connectors are color-coded black. See also LWL.

Target

Storage device that receives communications from a server or workstation over a Fibre 
Channel network. See also Initiator.

Topology

As applies to Fibre Channel, the structure of the Fibre Channel network and the resulting 
possible communication paths. There are three Fibre Channel topologies: point-to-point, 
fabric, and arbitrated loop.
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Translative mode

Mode in which public devices can communicate with private devices across fabric.

Transmission Character

A 10-bit character encoded according to the rules of the 8b/10b algorithm. See also 8b/10b 
encoding, Transmission Word.

Transmission Word

Group of four transmission characters, totaling 40 bits. Two types: data words and ordered 
sets. See also Data word, Ordered set, Transmission Character.

Trap (SNMP)

Message sent by SNMP agent to inform SNMP management station of critical error. See 
also SNMP.

Tunneling

Technique for enabling source and destination hosts to communicate when on same type 
of network but connected by a different type of network.

U_Port

Universal Port. Switch port that can operate as G_Port, E_Port, F_Port, or FL_Port. A port 
is defined as a U_Port if not connected or if it has not assumed a specific function in the 
fabric.

ULP

Upper Layer Protocol. Protocol that runs on top of Fibre Channel. Typical upper layer 
protocols: SCSI, IP, HIPPI, IPI.

Unicast

Transmission of data from a single source to single destination. See also Broadcast, 
Multicast.

Web Management Tools

Product that provides a graphical interface for monitoring and managing individual 
switches or entire fabrics from standard workstations.
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Well-known address

As applies to Fibre Channel, a logical address stored on the switch and defined by Fibre 
Channel standards as being assigned to a specific function.

WWN

Worldwide Name. Identifier that is unique worldwide. Each entity in a fabric has a 
separate WWN.

Zone

Set of hosts and devices attached to same fabric and having access permission, including 
RSCNs and user data, to each other. Entities inside a zone are not visible to entities outside 
the same zone, even if the outside entities are in another zone. See also Zoning.

Zone configuration

A specified set of zones. Enabling a zone configuration enables all zones in that 
configuration. See also Defined configuration, Enabled configuration.

Zoning

Product that allows partitioning of fabric into logical groupings of devices. See also Zone.
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